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INtro

This tutorial shows how to create and use Java TITAN Eclipse Project.

This kind of project based on languages TTGR, ASN.1 and Java.
The tutorial is restricted only for the first steps.

It uses step by step instructions instead of general and full description.
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Prerequisites

S Eclipse with installed TITANEclipsePlugins. (See install guide)
S Installed TITAN Core ( using C/C++ compiler) (if parallehode isused)
S Environment is set.

S User is experienced in the TITAN based on C/C++,
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Content

Concept of a TITAN Java project

Check the version of TITAN Eclipse plutns

Check the TITAN installation path

Create aHelloJavaTITANproject (create project, create ttcn3 module, create cfg file)
Build and run aHelloJavaTITANproject in single mode

Build and run aHelloJavaTITAN project in parallel mode

- -n-um-um-u-um
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TITAN Java Project

S Itis an Eclipse project with complete IDE support to develop and execute TTE&Nobased projects.

S It contains source files in TTCMNB language ( *ttcn files), in ASN.1 language (*.asn files) and in Java
language test (*.java) for implementation of test ports and external functions.

S Itis designed to give support the following workflow:

1. Generates Java files from TTCMNB, ASN.1 and Java files

2. Compiles .java files to .class files

3. Executes the compiled project(s) in single or in parallel mode

Jeno Balasko | xxx CNL 113 200/6 R6A Uen | PAl | 201®5-14 | | Page5 (38)



1. Checkhe TITAN Eclipse Plugins Version

1. Start Eclipse with installed TITAN Eclipse plugns.
2. Check the TITAN version. It shall be at least 6.6.0 (CNL113200/6 R6A):
S Select on menu Help>About Eclipse.

& runtime-2018-09_demo - C\Users\ethbaat\workspaces\runtime-2018-09_demo - Eclipse IDE - O hd

File Edit Source Refactor Mavigate Search Project Run Window Help

| X | | O | | ] | --- Me Launch Configurations '3-:"?":-:' Welcome
g - | - @B S (7} Help Contents Q- ~ @ ~

% Re=RP R - B~ =Rl ¥’ Search . @ TITAN Editing
Show Contextual Help 1

& Proje &2 . ‘% Con = B 9 P = O

- Show Active Keybindings... Ctrl+Shift+L

Report Bug or Enhancement...

Cheat Sheets...

=

e

itline iz not available.

3]

Eclipse User Storage >
Perform Setup Tasks...

e T

Check for Updates
Install Mew Software...
Eclipse Marketplace...

Arduine Downloads Manager

0O 0 G E&

About Eclipse IDE
Contribute
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2. Checlkthe TITAN Eclipse Plugins Version

Sgd

A X

;dCCbéi dEi AC?3 aas C

Uo i

S

File Edit Source Refactor

K]0]

m g
1 Nr=R0 g
7 Proje &2

a] -
| ® -
<,}==5>C|:|r1

Mavigate Search Project Run  Window Help

S About Eclipse IDE O >
Eclipse IDE for C/C++ Developers

Version: 2018-09 (4.9.0)
Build id: 20180917-1800

(c) Copyright Eclipse contributors and others 2000, 2018, All rights reserved.
Eclipse and the Eclipse logo are trademarks of the Eclipse Foundation, Inc,
https:/fwww.eclipse.crg/. The Eclipse logo cannot be altered without
Eclipse's permission. Eclipse logos are provided for use under the Eclipse
logo and trademark guidelines, https://www.eclipse.org/logotm/. Oracle and
Java are trademarks or registered trademarks of Oracle and/or its affiliates.
Other names may be trademarks of their respective owners.

This product includes software developed by other open source projects
including the Apache Software Foundation, https://www.apache.org/.

e

- - -
\2,' Installation Details

ﬁ"B;"
EC)‘C++ @1

~
o= 2

An outlineisn

[*] Problems &3 J=| Tasks| &) Console| [C] Properties

0 items
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3. Checlthe TITAN Eclipse Plugins Version

S Check if the version is at least 6.6.0:

& Eclipse IDE Installation Details

Mame

Ef‘,: Mylyn Tasks Connector: Bugzilla
[ Mylyn WikiText

(§: Qomph Setup

(k- RPM Tools

[ TITAN Log Viewer

Ef‘,: TITAMN_Designer_Feature

I-?f,c TITAMN_Executor_Feature

(§} Titan_external_dependencies

[ Titanium_external_dependencies
() Titanium_Feature

Ef’,: TM Terrninal

(fk TM Terminal Serial Connector Extensions

' Installed Software  |nstallation History Features Plug-ins

Configuration

Version

3.24,2.w201280905-0003
3.0.25.201806201740
1.11.0.,20181203-0741
7.0.1.201808121533
6.6.0.CRL_113_200_6_R6A._...
6.6.0.CRL_113_200_6_R6A._...
6.6.0.CRL_113_200_6_R6A._...
6.6.0.CRL_113_200_6_R6A_...
6.6.0.CRL_113_200_6_R6A. ...
6.6.0.CRL_113_200_6_R6A._...
4,5.0.201809101428
4,5.0.201809101428

Id

org.eclipse.mylyn.bugzilla_feature.feature....
org.eclipse.mylynawikitext_feature feature...,
org.eclipse.comph.setup.feature.group
org.eclipselinuxtocls.rpm.feature.group
TITAM_Log_Viewerfeature.group
TITAMN_Designer.feature.group
TITAMN_Executor.feature.group
Titan_external_dependencies.feature.group
Titanium_external_dependencies.feature.g...
Titanium.feature.group
org.eclipse.tm.terminal feature feature.gro...
org.eclipse.tm.terminal.connector.cdtseria...

O >
Provider (e
Eclipse Mylyn
Eclipse Mylyn

Eclipse Oomph Project
Eclipse Linux Tools
Eclipse Titan Project
Eclipse Titan Project
Eclipse Titan Project

Eclipse Titan Project
Eclipse.org - Target Manager
Eclipse.org - Target Manager

(4 Valgrind Tools Integration 7.0.1.201209121533 org.eclipselinuxtocls.valgrind feature.group  Eclipse Linux Tools W
< >
'r:?;' Update... Uninstall... Properties
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4. Checkhe TITAN Installation Path

S Select menu Window>Preferences>TITAN Preferences. The TITAN installation path shall be the root
folder of the TITAN (= $TTCN3 DIR):

=

type filter text

General

Ant

ANTLR 4

Asciidoctor Editor
Code Recommenders
Gradle

Help

Install/Update

Java

JSON

Maven

Model Editor

Mwed

Mylyn

Oomph

PlantUML Editor (Asciide
Plug-in Development
Run/Debug

Team

TITAM Common Prefere
TITAM Executor
TITAM Log Viewer
TITAM Preferences
Titanium Preferences
Validation

XML

TITAN Preferences P v
Preferences for TITAN L
TITAM installation path: | Ci\Users\ethbaat\git\titan.core\Install | Browse...

Use markers for build error notification instead of a dialeg.
[] Treat on-the-fly errors as fatal for build (the project will not build).

When On-the-Fly analyzation ends the compiler markers:

When the compiler runs the on-the-fly markers:

Stay unchanged

Stay ~

Maximum number of build processes to use: 8

Display debug preferences
Action on the console before build:

The version of the compiler used: CRL 113 200/6 R6A
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1. Create a Titan Java Project (Hello World )

SnEx®EAC CxE yEAAYEACUEE dt Et W 5AUCUi O8 ¢§J AEe&
perspective>0Others>TITAN Editing
S Create a TITAN Java Project
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Create a TITAN Java Project

Vd ~ " ~

S nE&EA i Eid >UseEdbOWEe bgAGAEACE

\\

£ runtime-2018-09_demo - Ch\Usershethbaat\workspacesiruntime-2018-09_demo - Eclipse IDE
File Edit Mavigate Search Project Run  Window Help

Mew Alt+Shift+M > g TITAMN Project b | ---
Open File... = Project...

[} Open Projects from File System... i ASNT Module
Recent Files > 3 TTCN2 Module
Close Crl+W % Cenfiguration file
Cloze All Ctrl+Shift+W 9 Folder

<‘\ .

Save Ctrl+5 R
Save As... ™ Example..
Save All Ctrl+5Shift+5 ﬁ Other... Chrl+ N
Revert
Move...
Rename... F2

& Refresh F5
Conwvert Line Delimiters To >
Print... Ctrl+P

Esy Import...

<5 Export...
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Create a TITAN Java Project

S nE&x®EAC

t Et

Wt Et

W M3 E3

& Mew Project

Select a wizard

Wizards:
type filter text

|

.

*

= General

[= C/C++

= RPM

w = TITAM

@ TITAN Java Project
@ TITAN Project

= Tracing

= Examples

@ < Back Next Finish

Cancel
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Create a TITAN Java Project

Create a TITAN Java Project <

Create a new TITAMN Java project in the workspace or in an external location

\\

Project name: | HellolavaTITAM

Use default location

Ch\Users\ethbaat\workspaceshruntime-2018-09_demo\Hello. Browse...
default
Gy .
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Create a TITAN Java Project

S The created project can be seen. Select the small arrow left to the project name:

=/
File Edit Mavigate Search Project Run  Window Help
& o ] --- Mo Launch Configurations
Fmil @~ BBEHLO@
5 Project &3 = O
08 & ¥

@ HelloJavaTITAN [ -f-e]
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Components of the Project

S We can see the content of the project. They role is as follows:

S src ttcn and .asn files

S user_provided .java files, implementation of test ports andtcn external functions

S java_src .java files generated from the content o$rc

S java_bin: storage for compiled .class files =

S Others are project administration files F!; E“:} ”;* = o
ul &% @~ D BEa
{5 Project &3 = g

=[G -

~ g HelloJavaTITAN [ -f -e ]
= java_bin [ excluded as
= java_src
= META-INF
= src
[= user_provided
=| build.properties
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Create al TCN-3 Module

S Select New>TTCN3 Module in popup menu of foldételloJavaTitan>src

-
w | HellolavaTITAM [ -f -]
= java_bin [ excluded a:

[ java_src
= META-INF
= Mew > [ Project..
= @ ASN1 Module
Show in Local Terminal > % Configuration file
& Copy Chrl+C |3 TTCM3 Meodule
Paste Ctrl+V < File
3 Delete Delete (9 Folder
Remaowve from Context Ctrl+Alt+Shift+Down M Example..
Move...
Rename... B ™ Other. Ctrl+N
= Import.
iy Export..

Jeno Balasko | xxx CNL 113 200/6 R6A Uen | PA1l | 20195-14 | | Pagel6 (38)

\\



Create al TCN-3 Module
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E Ui
& Mew TTCNI Module

New TTCN3 module
Create a new TTCM3 module

Enter or select the parent folder:

| HellolavaTITAN/ src

w g HellolavaTITAN [ -f -2 ]
= java_bin [ excluded as workingdirectory ]
(= java_src
= META-IMNF
= src
= user_provided

File name: | HW.then|

Advanced >»

| Pagel7 (38)
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Edit the File

S Edit and save the file according to the screenshot:

\\

£ runtime-2018-09_demo - HelloJavaTITAN/src/HW.tten - CUsers\ethbaat\workspacesiruntime-2018-09_derno - Eclipse IDE — | >
File Edit Mavigate Search Project Run  Window Help
‘ Q | | ()} ‘ ‘ | |0 Run VH Mew_configuration_hello W ‘ .- L | | & - =] EPS gﬁﬁ ﬁ @ @ Toggle Comment
R R R - R R R R R AR [Quick Access| | g5 | B ¢/C++ | TITAN Editing | % Debug
75 Project Explorer 52 = B |[[3) Hwiten 2 B fg.cfg W =/ MANIFEST.MF W =/ HU-0000D670-sing 1 = 0O |[g= o2 = 8
E|<}‘=={->|9 = 1= module HW- { ~ v ErE R
2
v i HelloJavaTITAN.[ -f-E]_‘ ) 3 type- component-CT-{} B 2§z
» mah JRE Systern Library [J25E-1.5] 4 -
» B Plug-in Dependencies 5= testcase tc() runs on CT {
5 [ java_src 6 log("Hello  Java  TITAN World!™); v |3 HW
o (™ user_provided 7 setverdict(pass); @ cT
4 N S g } o te()
B _Refere_nced Libraries _ _ 5 control{
» [= java_bin [ excluded as workingdirectory | 10 - execute(tc());
» = logs 11
» = META-INF 12
W [ src 13 ¥ b
3| HW.ttcn
% tcjfmli;propertles [#] Problems | &) Console &2 . @ Error Log} = bf E_J| B~ 0
g.crg
» = org.eclipsetitan.runtime_6.6.0.CRL_113_20( 'II'ITAN e
B temp.cfg
£ >
o | o [ [alo= 7
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Create a Configuration File

S nE®EAC dWEed, 6i OUOd A 3HelldXavaPraecke E@x E iUH

& runtime-2018-09_demo - HelloJavaTITAN/ sre/HW.tten - ChUsershethbaat\werkspaceshruntirme-2018-09_deme -
File Edit Mavigate Search Project Run  Window Help
& o ] {J) Run [T] Mew_configuration_hello -
L Project Explorer &% S| ¢ T F O |[B HW.tien 52
= H _
v e Mew *» [ Project.
=
) Enlli & ASN1 Module
o
Ln: Show In Alt+Shift+W > %5 Cenfiguration file
;” Show in Lecal Terminal * @ TITAN Java Project
= [ Copy Chrle C @ TITAN Project
& B Copy Qualified Name e
vzl o . S [P
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Create the Configuration File

S Write a config file name in. Then push Finish.

& New Configuration File

MNew Configuration File

Create a new configuration file

Enter or select the parent folder

| HelloJavaTITAN

o
@ HelloJavaTITAN [ -f-e]

File name: | cfg.cfg|

Advanced ==
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Edit the Config File

S A config file editor opens. In the section [EXECUTE] , write the project name to execute its control part:

£ runtime-2018-09_demo - HelloJavaTITAM/ cfg.cfg - C\Users\ethbaat\workspaces\runtime-2013-09_demo - Eclipse IDE — O x

File Edit Mavigate Search Project Run  Window Help

K| O |0 Run v | | Mew_configuration_hello v | At | @ ~: B
WS O @ TouskCommen itr O~ Qi A vilvhl ey | t
. B | B C/C++ | @ TITAN Editing | 45 Debug
T Ty Ty ™
7 Project Explorer = |3 ten E . 4 = =
75 Project Expl 5 B HW % cfg.cfg i MAMIFEST.MF . 8 |[o = B
= - 37 #EndTestCase :=""" A - |[
_ = =">| - 38 #BeginControlPart :=-"" "
w i HellolavaTITAN [ -f -2 ] A 39 #EndControlPart- := "" An outhne is not
» B JRE System Library [J25E-1.5] 46 available.
5> i\ Plug-in Dependencies 41 [EXECUTE]
5 [ java_src 42 #-In-this-section-you- can-specify-what-parts-of your-test-sui

43 HW.control

> [ user_provided 42 v

=i, Referenced Libraries

= java_bin [ excluded as workingdirect

>

% = logs

> & MEI:—I'A-INF cfg.cfg | Module parameter5| Testport parameter5| Components, Group...|
W

=
(= sre ' Problems | & Console &2 @] Error Logﬂ EE &

|3 HW.ttcn

>

I
[
1]
4
[l
4
i
ui

. . TITAM console [
= build.properties
% cfg.cfg _
» [Z org.eclipsetitan.runtime_8.6.0.CRL_" ,
o i 5 _
| J £1024M | ¢ !
|<3|‘.'_‘|| = |
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Edit the Config File

S Modify the section [LOGGING] with adding the USER log to tHeonsoleMask
ConsoleMask= USER | ERROR | WARNING | TESTCASE | STATISTICS | PORTEVENT
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Build the Project

S NExeEAC dg+dUaA gAO6AaAEACS8 HélloJa@XEANg oW A

& runtime-2018-09_demo - HellelavaTITAN/ sre/HW.tten - ChUsers\ethbaat\workspacesiruntime-2012-09_demnc - Eclipse IDE - O it
File Edit Mavigate Search Project Run  Window Help
Open Project allel W | A | & @®~: 8
1 Close Project 1
+3 'rmm TITAH @ @ TDgg'E': ' e hd - ¥ (::I - v| m
ay  Build All Ctrl+B : - -
|y Bui rl+ EI - | R C/Ce+ @ TITAN Editing % Debug g TITAN Executing
Build Project :
f_ N = 4 = ~ {'D; = ~
L Project £ - Build Working Set > O ||o= 0% -
) = <§>| C Clean... - %= x| 5
Ve HE”D'I“aTlTAN_[ il Build Automatically W |
B JRE Systern Library [12
B\ Plug-in Dependencie: Properties ' [
[ java_src ——g——TpgHerro-rava-rrrarworld! ") ; -
[ user_provided ; ) =il e w |3 HW
= java_bin [ excluded as 9 control{ e
(= META-INF 18 execute(tc()); TR
w [ src 11 } W
|3) HW.tten e
= build.properties .
9 cfg.cfyg [*! Problems &2 =2 lesole} | Error Logﬂ :=:{>| @& ~ — 0
0 items
Description Resource Path Location Type
£ > £ >
@ HelloJavaTITAN o (s of 1024 [
Al o= 7
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The Result of the Build

S dl a3 E38 OUxEA e UeaxxjavaBraOBii BACKEA Ul jakedsitdolias s AmE

S runtime-2018-09_demo - HelloJavaTITAN/ sre/HW.tten - C\Users\ethbaat\workspaces\runtime-2018-05_demo - Eclipse IDE — O >
File Edit Mavigate Search Project Run  Window Help
@ Q Run [T HellolavaTitan_parallel iR | ) @ - El ] ?I:EE e @ 13
i~ O~ Q~-im Vi F e [Quick Access| | [ | T3 C/Co+ | @ TITAN Editing | %5 Debug @ TITAN Executing
Project Explorer ® 3| HW.ttcn = O
() Project Explorer &3 2E|e = O] 2 = 8 |(%ox~ = &
v i@ HelloavaTITAN [ -f-¢] 1= module  Hil- { BEE WK
=i, JRE System Library E by
=i Plug-in Dependencies - type component CT{} |
v [(# java_sic 5= testcase tc() runs on CT { s
B (default package) 6 log(“"Hello Java TITAN World!™); -
7 t dict H
g 2:3 cipee ! setverdict(pass); v 3 HW
’ g cT
£ org.eclipsetitan I 9 control{ =)
. . 18 - execute(tc()); W tel)
£} org.eclipsetitan.HelloJavaTITAN 11}
w H3 org.eclipsetitan.HelloJavaTITAN.generated 12
1] HW.java 13 }
[J] package-infojava 14
[7] Parallel_main.java
[4] single_mainjava
[*® user_provided
v [= java_bin [ excluded as workingdirectory ]
v [= org
w [ eclipse
w [ titan
w = HelloJavaTITAN
~ [= generated
fﬂ}, HW.class
fﬂb HWSanytype_template.class
fuib HWSanytype.class
fib HWSanytypeSunion_selection_type.clz [[#] Problems &2 &l Console | 2| Error Log | v = 0O
b HWSCT_template.class 0 errors, 3 warnings, 0 Dtheri\
futp HWSCT.class Description Resource Path Location Type
fﬂb package-info.class T B
b Parallel_main.class - araingsiiSliteme)
fﬂ}, Single_main.class
= user_provided
i META-INF
V[ srC
3] HW.tten
|=| build.properties
B cfg.cfg
< > ([ <
@ HellolavaTITAN [on i T24M of 1024M o: k==
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Running the Project In Single Mode

\\

S nExeEAC | di Adb jdi , 6i OUOdAs CU

11 Project Explorer &2 = <§|>| ® - - |3 HW.tten B2
v i Hell-'——Tmanir s 3 1= madule Hil- {
B ) New ¥
= F Go Into pe- component CT {}
2 ji S ol Alt+Shift=\ » jstcase tc() runs-on CT-{
[Z2 log("Hella Java TITAN World!™);
= Show in Local Terminal > | setverdict(pass);
. ;—'}_j : [E Copy Gr+C  ntrol{
FLE] Copy Qualified Name xecute(tc());
= b [[3 Paste Ctrl+V
§ ¢ 38 Delete Delete
Remove from Context Ctrl+Alt+Shift+ Down
Build Path »
Refactor Alt+5Shift+T »
[ Import.
g Export..
Build Project
Refresh F3
Close Project
Close Unrelated Project
Pro.flllnch-oIs ’ ems &3 ) Console| ¥ Error Log
Validate . T
{J RunAs » [T] 1Java Application Alt+5Shift+ X, |
5  Debug As > ﬁ 2 TITAN INI launcher
Profile As » ;' 3 TITAN Parallel launcher
Restore from Local History... o ST I e
Team »r
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Running the Project In Single Mode

S

\\

16dy¢ E AeUA&a o1 dM3ES? y
;dCCo6il >U@seae CxE OUEa=AA

A3 ( 8 U 6A A=:UAa
3 Ui A3 AA AKX

X 0O
m C
(@)

—

& Run Configuraticns O d
Create, manage, and run configurations —y
Run a Java application @
léf \ S | — Mame: | Mew_cenfiguration_hello |
type filter text (D Main . 9= Arguments| &), JRE| % Classpath| & Source| I Environment
1) Build Decker Image & ,

.

E C/C++ Application

[E] C/C++ Container La
[E] C/C++ Remote Appli | HelloJavaTITAN || Browse.
Cif C/C++ Unit

{3 Docker Compose
1 Java Applet | org.eclipsetitan.HellolavaTITAM.generated.Single_main | Search...

Project:

Main class:

v [I] Java Application [ Include system libraries when searching for a main class
[T Mew_configuratio

Jur JUnit

i Launch Group

@ Launch Group (Depre
Launch over Serial

[ Include inherited mains when searching for a main class
[]Stop in main

&p Run Docker Image
';j’ TITAN JNI launcher
@ TITAN Parallel Iaunc}'

i TrTAREFT 0 R

< >

i ) Show Command Line Revert Apply
Filter matched 17 of 17 itermns :

W, Run Close
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Running the Project In Single Mode

S Note: In single mode, the execution relies totally on the Java workflow: the Java code generated by
the codegenwill be built and executed.
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unning the Project in Single Mode

SEi CxE C3¢ d AOdiEiCA8e Ui
AEa® CUEE C6 CxE yAOAEAC Oo06@

Create, manage, and run configurations —

Run a Java application @

BoERX| B -

Mame: | MNew_configuration_hello |

type filter text © Main (9= Arguments .=\ JRE| % Classpath | & Source| I Environment | (=] Common| [p| Prototype
[/ Build Docker Image Program arguments:
[€] C/C++ Application
[E] C/C++ Container Launcher
[€] C/C++ Remote Application
Cif C/C++ Unit
D Docker Compose Variables...
1] Java Applet

w [1] Java Application

cfg.cfgl

VM arguments:

[T] New_configuration_hellc
Ju JUnit
i Launch Group
= Launch Group (Deprecated;

Variables...
Launch over Serial

@i Run Docker Image Waorking directory:

{§ TITAN NI launcher @® Default: ${workspace_loc:HelloJavaTITAN}

% TITAN Parallel launcher

:§ TITAN Single Mode launchs ||| O Other:

Workspace... File System... Variables...

£ >
. . Show Command Line Revert Apply
Filter matched 17 of 17 items
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The Result of the Running

S The project will be executed. The run will be logged on the console and in config file(s):
The console and the file log:

& runtime-2018-09_deme - HelloJavaTITAN/org.eclipse titan.runtime_6.6.0.CRL_113_200_6_R6A_20190314-1433.HU-00000670-single.log - C:\Users\ethba... - O X
File Edit Mavigate Search Project Run  Window Help i
@ {J Run [T1 MNew_configuration_hello - | |md @ - =] %35 ﬁﬁﬁ o @ @ i
Q"R -BE T oy | 2 ; 7 | @ C/C++ @ TITAN Editing %5 Debug
5 Project Explorer 3 = 8 || 3] HW.tten B cfg.cfg = org.eclipse.tit I3 % = O |[B= o = b
=| <}=|,=>| = I 1 pe19/May/14- 17:22:44 . 689888 EXECUTOR- - TTCN-3- Test- Executor- started a <
v 7 HelloJavaTITAN | - -¢ | i 2 2819/May/ /14 17:22:44, 696808 EXECUTOR - Using configuration file: "¢ An outlineisnot.
@ Mellofava S 3 2819/May/14 17:22:45.02480@ EXECUTOR - TTCN- Logger v2.2 options: Tir L
B JRE System Library [J25E-1.5] 4 2019/May/14 17:22:45.025000 EXECUTOR - Initializing module PreGenRe :
E\ Plug-in Dependencies 5 20819/May/ /14 17:22:45,025608 EXECUTOR - Initializing module- PreGenRe:
(8 java_src 5 20819/May/ /14 17:22:45,0250808 EXECUTOR - Initializing medule TitanLogg
(. user_provided 7 2819/May /14 17:22:45.025888 EXECUTOR - In:i.t:i.al:i.z:i.ng module - TitanLogg
Referenced Libraries 8 2819/May/ /14 17:22:45.0825888 EXECUTOR - Initializing module- Hil.
_E"‘ ) _ o 9 2819/May/14 17:22:45.025808 EXECUTOR - Initializing module HW finist
(= java_bin [ excluded as workingdirectary | 10 2019/ May/14- 17:22:45,025800 STATISTICS -- Execution of - control- part-:
(= logs 11 2819/May/ 14 17:22:45,630000 USER - Helle Java TITAN World! [
= META-INF 12 2819/May /14 17:22:45.832800 STATISTICS - Executicn of contreol part :w
[ src < >
|3 HW.tten [® =] (] ="NY-RE ™~ &2 = B8 I
=) build.properties . Problems Console &2 w | Error Log | 9% %l =" ._,JE] = E @l i ﬁ 7
cg cfg.cfg <terminated> Mew_configuration_hello [Java Application] C:\Program Files\Java\jrel.8.0_181\bin'javaw.exe (May 14, 2019, 2:37
= — . - Using configuration file: “cfg.cfg’ ~
B GrpaE et E T e Execution of control part in module HW started.
B temp.cfg Test case tc started.
Hello Java TITAN World!
Test case tc finished. Verdict: pass '
Execution of control part in module HW finished.
Verdict Statistics: @ none (@ %), 1 pass (188 %), @ inconc (@ %), @ fail (@ %), @ error (8 %) i
Test execution summary: 1 test case was executed. Overall verdict: pass
Total execution took B.631798645300808801 seconds to complete v
< > < >
#1 || witable Insert 1:1: S Mg 024M [ e i

T T UTErETOv e TT
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Running the Project in Parallel Mode

S Important note: as the main controller has not been yet written in Java, code execution in parallel
mode relies on the legacy (C++) main controller, that has to be started from command line. This results
In a hybrid execution: the legacy main controller and the Java components will work together to get
the expected result. In the future, this will changeto a pure Java execution, much simpler from
users point ofview, with no needfor commands in a separateconsole.
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Running the Project in Parallel Mode
Set theinternal TCPPortin the Config File

S If the project contains more then one component ( contains component create statement ) then the
project can run only in parallel mode. But even our first project can run in parallel mode.

S In parallel mode the Main Test Controllerrctr_cli) will control the Host Controller (HC) and every

parallel test component (PTC).
S Before running we suggest to define thanternal TCPport number, which themctr_cli controls the

components. It requires to step:
1. Inthe cfg file set the internal TCPPort

Wl 522 [MAIN_CONTROLLER]
53 # The-options-herein- control-the- behavior-of - MC.
55 TCPPort := 5999
56 KillTimer: :=-18.8
57 # NumHCs-:=-8
55 #-LocalAddress: :=
59
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Running the Project in Parallel Mode
Start the Main Controller

2. Start the mctr_cliin a terminal, in the project folder. It will listen on the port specified in the cfg file.

fruntime-2018-09_de
9_demo/Hel loJavaTITAN

s/runtime-2018-09_demo,/HelloJavaTITAN

TTCN-3 Test Executor - Main Controller
Version: CRL 113 200 O

Copyright (c) 2000-2 ) Ericsson Telecom AB
All rights reserved.

Using configuration file: cfg.cfg
HU-000006/0: Listening on TCP port 6999.
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Running the Project in Parallel Mode
Start the Host Controller

3. nEaxeEAC
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J, di

Ein| P.roject Explorer % -

#F 0

o S - =

~ g Hell-'=--Trmanie s -1
B ) MNew
B F Go Into
E::: JL Show In
& j Show in Local Terminal
&N Copy
vi=zs
3 5= Copy Qualified Mame
= b [[3 Paste
% ¢ 38 Delete
Remove from Context
Build Path
Refactor
i Import.
g Export..

Build Project
Refresh
Close Project

Close Unrelated Project

Profiling Tools
Validate

Run As
Debug As
Profile As

Restore from Local History...

Team

| Page33(38)

j di

|3 HW.tten &2

t=madule Hil- {

»

Alt+Shift+W >
>

Ctrl+C

Ctrl+V
Delete
Ctrl+Alt+Shift+ Down
»
Alt+5Shift+T »

F3

pe- component CT {}

stcase to() runs-on CT-{
log("Hella Java TITAN World!™);
setverdict(pass);

ntrol{
ecute(tc());

ems &3 ) Console| ¥ Error Log

[T 1Java Application
2§ 2 TITAN NI launcher
& 3 TITAN Parallel launcher

Alt+Shift+X, ]

Run Configurations...

-

|1rPr‘|‘-‘.P kP 1% walld.
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Running the Project in Parallel Mode
Start the Host Controller

6d¢ eeE A&UAa 6 i QM3E3 yy&UA3CU

e e mi s ———— o . ——— P ———— — T

| e |
Create, manage, and run configurations —
Run a Java application @
i
L = ¥ | = Marne: | HellolavaTitan_parallel |
type filter text (9 Main". 09= Arguments | B JRE L Classpath E Source | B8 Environment| ™z |
) Build Docker Imag A Project:
[t] C/C++ Applicatio
2] C/C++ Container | HellolavaTITAMN | Browse...
[€] C/C++ Remote Ay Main class:
3 Cif C/C++ Unit
O Docker Compose | org.eclipsetitan.HellolavaTITAM. generated. Parallel_main | Search...
B0 Java Applet [l Include system libraries when searching for a main class
v [1] Java Application [l Include inherited rmains when searching for a main class
O] Mew_configura W
[T] New_configura
Ju JUnit v
< >
i ) Show Command Line Rewvert Apply ]
Filter matched 12 of 18 items f
'i?::' Run Close [
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Running the Project in Parallel Mode

Start the Host Controller

4, nE®e®EAC CxE dq AOdi

Ei CA8 C:3 ¢

A OUeaa

\\

CxE O6Ai

the Host Controller (HC). The first argument IS the (IP) address of tinectr_cliand the secondarg IS
the port number of themctr clil

|3 HW.tten % fg.cfg 2
37 #EndTestlase :=-""
38 #BeginControlPart::=

39 #EndControlPart :=""

M

AR
1 [EXECUTE]
42 # In- this section you
43 HW.control

45 [GROUPS]
45 # In this section- you
47 # [COMPONENTS] - section

49 [COMPOMENTS]
58 # This-section-consist

52 [MAIN_CONTROLLER]
53 # The options herein-g

55 TCPPort := 6999
56 KillTimer: :=-18.8
57 # HumHCs-:=-8@

58 # LocalAddress-:=
59

cfg.cfg | Module parameters Testp-:

1®! Problems | & Console &2 6

| S

| Run a Java application

EECEER. 4

type filter text

) Build Docker Imac

[T] C/C++ Applicatio

[€] C/C++ Container

[T] C/C++ Remote &

Cii C/C++ Unit

{3 Docker Compose

1 Java Applet

~ [1] Java Application

77 Mew_configura
7] Mew_configura

£ >
Filter matched 18 of 18 ite

Y
(?
‘,L/I
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.+ Create, manage, and run configurations

>Usxee CxE O Al

|\ JUICK ACCESS] |

E

o

Mame: | HellolavaTitan_parallel |

© Main [(= Arguments

¥

=\ JRE| ¥ Classpath | B Source| ™3

Program arguments: "
localhost 6999
Variables...
VM arguments:
.
Show Command Line Revert Apply
!
Run Close i
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Running the Project in Parallel Mode
Start the Host Controller

S The HC starts and connects to thenctr_cli. Themctr clireflects that.

\\

E ~fworkspaces/runtime-2012-09_demo/Hello)avaTITAN

* TTCN-3 Test Executor - Main Controller

* Version: CRL 113 200/6 R6A

* Copyright (c) 2000-2019 Ericsson Telecom AB

* All rights reserved. This program and the accompanying materials
are made available under the terms of the Eclipse Public License

* which accompanies this distribution, and is available at

* https:// ecli ' ' ' 2.0/EPL-2.0.htmT

Using configuration file: cfg.cfg
@HU-00000670: Listening on TCP port 699
- MC@HU-00000670: New HC connected fr

m-HU—GGGGGﬁFG.EF1CSSDH.SE [127.0.0.
1]. HU-00000670: windows 10 10.0 on amd64.
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Running the Project in Parallel Mode
Create MTC and start MTC. Logs

SEi CxE CEAi Ui 3 xeémc8gYE AGEE CEGI B Ui AsoEsy CU AC 3yAG E
S TITAN will log into the console and into the log file. The console log:
E

TTCN-3 Test Executor - Main Controller 2
CRL 113 200/6 R
ght (c) J00-2019 Ericsson Telecom AB
11 rights S This program and the accompanying materials
are made available under the terms of the Eclipse Public License
which accompanies this di ailable at
https://www.eclipse.org/or 0.html

ing configuration file: cfg.cfg
AHU-00000670: tening on TCP port

0: New HC connectec frcm.HU—OOOOO ).ericsson.se .0.0.1]. HU-00000670: windows 10 10.0 on amd64.

ng configuration file to all HCs.
The address of MC was set to a local IP address. rAif

This may cause incorrect behav a HC from a

nfiguration file was proce on all HC
eating MTC on host HU-00000670.ericsson.se.
C is created.

all items of [EXECUTE] section.
HU-000006 Execution of control part in module HW started.

Hello Java TITAN d!
Test case tc finished. rdict: pass
: Execution of control part in module HW finished.
Test execution finished.
section finished.
Terminating MTC.
. stics: 0 none (0 %), 1 pass (100 0 inconc (0 0 fail (0 % 0 error (0
Test execution summary: 1 test case was executed. v pass
MTC terminated.
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File Log

S The file log:
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